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MT4 navigational tips and techniques

(NEW MATERIAL IN RED TYPEFACE)

Hi all

The following post used to be a sticky in the MetaTrader forum, but it appears to have been lost. Hence I'm re-posting it

here.

Use of the mouse and mousewheel, and their keyboard equivalents

Scrolling the chart

Hold down the left mouse button and drag the mouse in the main chart area, to scroll left/right.

Or you can also simply roll the mousewheel down/up, or use the left/right arrow keys, to likewise scroll the chart view

left/right.

To scroll a whole screen at a time, use Page Up (scroll left) and Page Down (scroll right).

To reposition to the leftmost bar on the chart, press Home.To reposition to the most recent (rightmost) bar, press End.

To step forward one bar at a time, press F12.

To step backward one bar at a time, press Shift-F12.

Scrolling a chart beyond the leftmost bar will add historical bars to the beginning of the chart, until no more are available

from MT4's historical database.

Moving directly to a certain date/time

To re-position immediately to a certain date, press Enter, then type in the date in the form DD.MM.YY and press Enter

again. Leading zeros can be omitted (e.g. to move to 4 July 2005, type 4.7.5). To re-position to a certain date/time, use the

format HH:MM or DD.MM.YY HH:MM (e.g. to position to 8:07am TODAY on a 1-min chart, simply type 8:7).

You can also use the "Fast Navigation Box" to change either the currency symbol, or the period, thus:

Inserted Code

1. time (hours:minutes)         example: 08:30; 8:30;   

2. date                         example: 2004.10.16; 16.10.2004; 16.10.04;   

3. date and time                example: 2004.10.16 8:30; 16.10.2004 8:30; 16.10.04 8:30;   

4. symbol                       example: GBPUSD; EURUSD;   

5. chart period                 example: M1; M5; M15; M30; H1; H4; D1; W1; MN;   

6. symbol, chart period         example: GBPUSD, M30; EURUSD, D1;

Vertical zoom and re-scale

You can re-scale the chart vertically by moving the mouse into the vertical axis area at the right of the screen, and then

dragging downwards (with the left button held down) to compress the chart bars, or dragging upwards to expand them.

Double click to reset the chart to its original scale.

Horizontal zoom and re-scale

Similarly, you can adjust the width of the price bars by moving the mouse into the horizontal axis area at the bottom of the

screen, and then dragging right (zoom in) or left (zoom out). Or simply use the "+" and "–" keys to achieve this.

Indicators

Double-click on or near indicators with the left mouse button, to call their parameter setup windows.

Right-click to call the indicator's context menu.

If the screen is cluttered with overlapping indicators and/or objects, making it too difficult to select the desired indicator,

press Ctrl-I to call up the Indicators dialog window. Double click (or click the Edit button, or Alt-E) on the indicator to edit

its properties (parameters, colors, etc), or click the Delete button (or Alt-D) to remove it from the chart.

You can use the Home, End and Page/arrow Up/Down keys to navigate up/down the list.

Objects

Double-click on or near an object (line studies, texts, arrows, geometric shapes) to select the object. Once selected, you can

move an object by left clicking on it (or in the case of or trendline or shape, it's center handle) and dragging it to the desired
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destination. Shapes, trendlines, channels etc may be extended by dragging the handles on the relevant edges. The number

"X/Y" appears, where "X" = the width of the shape in candles, and "Y" = the height of the shape in pips.

Right-click on a selected object to open its context menu.

If the screen is cluttered with overlapping indicators and/or objects, making it too difficult to select the desired object(s),

press Ctrl-B to call up the Objects dialog window. Left click the check boxes on/off to select/deselect relevant object(s).

Double click (or click the Edit button, or Alt-E) on an object to edit its properties (parameters, colors, etc), or click the

Delete button (or Alt-D) to remove it from the chart. To quickly delete a whole block of objects, repeatedly press Alt-D or

hold it down (careful, they disappear rather quickly!)

You can use the Home, End and Page/arrow Up/Down keys to navigate up/down the list.

Click on the 'Name' or 'Description' heading area to sort by name, or description, respectively.

Left-click to select an item. You can use Ctrl-click to add individual items to a selection, Shift-click to add a group of

consecutive items, or press Ctrl-A to select all items. Then click the Edit button (or press Alt-E) to edit all items in the

group consecutively, or the Delete button (or press Alt-D) to delete all selected items simultaneously (careful!).

Alternatively, from the chart window, press Backspace repeatedly to delete the most recently added object(s) on a

last-added-first-removed basis (useful if you want to quickly check out a Fibo or regression channel, then remove it). Then

press Ctrl-Z to undo any accidental deletes, in reverse order.

Or press the Delete key to remove ALL SELECTED objects.

Parallel Trendlines

Ctrl + left click on a selected trend line to draw a parallel trend line (create a channel). Can also be used with vertical and

horizontal lines.

Duplicating objects

The 'Parallel Trendlines' concept extends to ALL objects (vertical, horizontal and trend lines; shapes - triangle, square,

ellipse; text and labels; arrows and symbols; and studies like channels, Fibo, Gann, Pitchfork, etc). Here's how to duplicate

any object:

-- Select the object by clicking on it**

-- While holding down the Ctrl key: move the mouse over any one of the object's handles, and, holding down the left button

drag the mouse to where you want the duplicated object to be located

This shortcut also duplicates all of the proprties of the parent object, e.g. if you have red, green and blue objects, and you

want to create a green one, simply duplicate it. This is quicker than creating a new object, and then changing its color to

green.

** Object selection options

Press Ctrl-O and then select the 'Objects' tab.

-- "Select object by single mouse click" - if checked OFF, you must double click to select an object, and right click to modify

its properties. If checked ON, single click to select an object, and double click to modify its properties.

-- "Select object after creation" - if checked ON, any object is automatically selected immediately after you create it.

-- "Show properties after creation" - if checked ON, the property modification window for the object is displayed,

immediately after you create the object.

OR

Press Ctrl-B to display the objects list. Click on the checkbox (at left) for each object you want selected.

Information Bubble

Hover the mouse cursor on or over an element, object or indicator to see the prompt (help information bubble).

Crosshair mode, and ruler tool

Click the mousewheel to switch cursor to the "crosshair" mode.

This can also be achieved by pressing Ctrl-F, or selecting the crosshair icon from the toolbar. The crosshairs also display

vertical (price) and horizontal (date/time) co-ordinates at the right and bottom of the chart.

Simply left-click to exit crosshair mode.

Now, here is something extremely useful that I haven’t found in the on-line help:

While in crosshair mode, hold down the left mouse button and drag the mouse to obtain a ruler-type tool that measures

vertical (number of pips) and horizontal (number of bars) from the center of the crosshairs. The tool displays counters in the

form "A/B/C" where A is the number of bars right or left of the crosshair, B is the number of pips from crosshair to cursor,

and C is the price at the cursor.

I find "B" extremely useful for measuring the number of pips between any two points, thus:

1) move the mouse to the point you want to measure from (the "anchor" point);

2) click the mousewheel to enter crosshair mode;

3) then hold down the left button and move the mouse to any number of destination points, to see the number of pips

between the anchor point and the current mouse destination.

This saves having to calculate this distance manually, as the difference between two prices. Pretty cool!

You can also use this facility to count price bars (reading "A") between any two dates/times.
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Reference and anchor points

'Fixed chart position' arrow: At the lower left of the chart there is a dark colored** arrow. Dragging it with the mouse sets

the reference (anchor) point for the chart. Now when you zoom in or out, or even change the timeframe, this point remains

anchored at its existing location.

'Chart shift' arrow: At the upper right of the chart there is likewise a dark colored** arrow. Drag it left or right with the

mouse to set the location for the last (most current) bar on the chart (i.e. set the amount of empty "whitespace" at the right

of the chart).

[** the color is actually set to the same color as the Grid color (press F8 to change the Grid color in the chart Properties

window). Hence if the arrows are difficult to see, change the Grid color to a color that contrasts better with the chart

background.]

Removing all indicators and objects from your chart

Load a blank chart (the pair/timeframe doesn't matter), then change the settings (press F8) to set colors, grid, etc to suit

your preference. Then save this as a template named (for example) Z. (menu option: Charts > Template > Save

Template……)

Then, whenever you want to instantly remove all indicators and objects from your chart, simply load template Z, by quickly

using the hotkey combination: Alt-C T Z

The 'Grid' and 'Volumes' color selections (obtained by pressing F8 to summon the chart Properties window) each serve

dual purposes. The Grid color doubles both as the color for the chart grid (press Ctrl-G to toggle the grid on/off), but also

the color for the horizontal Bid price line. Hence if you don't want the Bid price line cluttering your chart (e.g. it's easily

confused as another S/R line), and you never use the grid facility, then set the Grid color to 'None', and the Bid price line

disappears. I use the Bid/Ask line indicator that I've attached to this post, instead. You can of course turn the Ask line off

either by setting the 'Ask line' color to 'None', or by unchecking 'Show Ask line' on the Common tab.

The 'Volume' color selection doubles both as the color for volume bars (press Ctrl-L to toggle these on/off) and also as the

color for the order entry level lines. Hence if you don't want these lines cluttering your chart, and you don't use the Volume

facility, then set the 'Volume' color to 'None', and the order entry level lines will disappear. Of course you can suppress the

displaying of SL and TP level lines by changing the 'Stop Levels' color to 'None'.

List of hotkeys

There are many other useful hotkeys. Here is a comprehensive list:

Left arrow — scroll chart to the left;

Right arrow — scroll chart to the right;

Up arrow — quickly scroll chart to the left or (if the scale is defined), scroll chart upwards;

Down arrow — quickly scroll chart to the right or (if the scale is defined), scroll chart downwards;

Numpad 5 — restores chart vertical scale to its original default. If the scale was defined, this returns the chart back to its

visible range;

Page Up — scroll a whole screen to the left;

Page Down — scroll a whole screen to the left;

Home — move the chart to the start point (first bar);

End — move the chart to the end point (last, i.e. most current) bar;

"–" — zoom out (there are 6 levels of zoom available);

"+" — zoom in;

Delete — delete all selected objects;

Backspace — delete most recently added objects, on a last-added-first-removed basis;

Enter — open/close the fast navigation window;

Esc — close any dialog window;

F1 — open the on line help "Userguide";

F2 — open the "History Center" window;

F3 — open the "Global Variables" window;

F4 — open MetaEditor;

F5 — switch to the next profile;

F6 — call the "Tester" dialog window for testing the expert attached to the chart window;

F7 — call the properties dialog window of the expert attached to their chart window, in order to change its settings;

F8 — call the chart setup dialog window, allowing basic chart parameters, colors, etc to be changed;

F9 — call the "New Order" window, allowing the entry of market, limit, stop orders;

F10 — open the "Popup prices" window;

F11 — enable/disable full screen mode;

F12 — scroll the chart one bar to the left;

Shift+F12 — scroll the chart one bar to the right;

Shift+F5 — switch to the previous profile;
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Alt+1 — display the chart as OHLC bars;

Alt+2 — display the chart as OHLC candlesticks;

Alt+3 — display the chart as a line (closing prices only);

Alt+A — copy all test/optimization results onto the clipboard;

Alt+W — call the chart management window;

Alt+F4 — exit the program;

Ctrl+A — arrange all indicator window heights by default;

Ctrl+B — call the "Objects List" dialog window;

Ctrl+C or Ctrl+Insert — copy to the clipboard;

Ctrl+D — open/close the "Data Window";

Ctrl+E — enable/disable the attached expert advisor;

Ctrl+F — switch to "Crosshair" mode;

Ctrl+G — show/hide the vertical/horizontal grid;

Ctrl+H — show/hide the OHLC line;

Ctrl+I — call the "Indicators List" dialog window;

Ctrl+L — show/hide volume data on the main chart;

Ctrl+M — open/close the "Market Watch" window;

Ctrl+N — open/close the "Navigator" window;

Ctrl+O — open the "Setup" window;

Ctrl+P — print the chart;

Ctrl+R — open/close the "Tester" window;

Ctrl+S — save the chart prices (OHLCV) in a file having extensions: "CSV", "PRN" or "HTM";

Ctrl+T — open/close the "Terminal" window;

Ctrl+W or Ctrl+F4 — close the chart window that's currently in focus;

Ctrl+Y— show/hide date (period) separators;

Ctrl+Z or Alt+Backspace — undo object deletions in the reverse order they occurred;

Ctrl+F6 — switch to the next chart window;

Ctrl+F9 — open the "Terminal — Trade" window and switch the focus into it, allowing trading operations to be entered via

the keyboard.

Attaching indicators to indicators outside of the main price chart
You can attach moving averages and other indicators to indicators on other than the main chart. For example, if you want to

use a moving average to smooth RSI, do the following:

1) Create a lower window with RSI in the normal manner.

2) Open the navigator window (press Ctrl-N).

3) Click on the "Indicators" heading in the Navigator window, if necessary, to expand it.

4) Move the mouse to the "Moving Average" item, then (holding down the left button), drag it (a rectangle appears under

the arrow cursor) into the RSI window.

5) In the ensuing dialog box, got to the "Apply to" drop down, and set this to "First indicator's data". This will cause the MA

to be attached to the first indicator in this window, i.e. the RSI.

6) Adjust other parameters as desired, and press Enter.

NOTE:

-- To create an indicator in a separate window, right-click on its name in the Navigator, and select "Attach to a chart".

-- To create an indicator in the same window as another, drag it's name into the relevant window.

Adding custom-defined indicators to MT4
One of the most powerful MT4 features is that it has a comprehensive but friendly programming language that allows

custom-defined indicators, scripts and expert advisors to be written. Here's how to import an already written indicator into

MT4's charting facility:

1) Go to a web resource that has the source code for the indicator. A good one is http://www.xeatrade.com/trading/11.html

Note the "# A B C D E F G H I J K L M N O P Q R S T U V W X Y Z" index.

So if you want to add (for example) the PPCI indicator to your charts, click on "P" to see all the custom-developed indicators

starting with a "P".

Left-click on the PPCI hyperlink. The source code for PPCI appears in the middle of the screen. Left-click inside this window,

then press Ctrl-A to select all of the text, then Ctrl-C to copy it.

2) Return to MT4, and press F4 to load the MetaEditor, a tool which allows to create and compile your own indicators, scripts

and experts.

3) In MetaEditor, press Ctrl-N to create a new indicator using the Expert Advisor Wizard.

Select the "Custom Indicator" radio button, and click Next.

Type in the name (e.g. PCCI) that you want to use to reference your indicator in MT4, ignore the other fields, and click Next.

On the final dialog window, ignore all fields, and click Finish.

4) Now left-click in the body of the screen, press Ctrl-A to select all the text, and then press Ctrl-V to paste the text you

copied back in step 1, completely overwriting the previous text.

Broker Specs

Platform Tech / MT4 navigational tips and techniques Reply to ThreadPage 1 492 3 4 5 6

MT4 navigational tips and techniques @ Forex Factory http://www.forexfactory.com/showthread.php?t=67529

4 of 13 1/15/2016 1:56 PM



Hopefully, the message "0 error(s), 0 warning(s)" will appear, indicating a "clean compile", i.e. that the programmer wrote

the source code correctly, without syntax errors. Press Esc to close the dialog box.

Presto! If you now return to MT4, the new custom indicator should automatically appear both in the Navigator, and also

under the menu option "Insert > Indicators > Custom" if you prefer to add it to your chart in this manner.

You can also add scripts and experts in the same way.

In step (1), select the "MQ4 Scripts" or "MQ4 Experts" hyperlink in the left menu.

In step (3), select the appropriate radio button.

Note that these objects are stored in the following folders:

Experts: c:/program files/<mt4 broker name>/experts

Scripts: c:/program files/<mt4 broker name>/experts/scripts

Custom indicators: c:/program files/<mt4 broker name>/experts/indicators

Include (program code, e.g. .MQH) files: c:/program files/<mt4 broker name>/experts/include

Templates: c:/program files/<mt4 broker name>/templates

Data files: c:/program files/<mt4 broker name>/experts/files

NOTE: As an alternative to the above, if you simply copy the .MQ4 file into the relevant folder, and then (exit and) re-start

MT4, the expert, script or indicator will automatically be recompiled, and appear in the Navigator.

Some other good sources for MT4 indicators (apart from FF's search facility):

http://www.forexfactory.com/showthread.php?t=62722 (see ZIP file attached to post #1)

http://www.forex-tsd.com (perform a forum search)

http://codebase.mql4.com/ (peform a site search)

http://www.forexmt4.com/_MT4_Indicators/

http://www.desynced.net/fx/eas/indicators.php

http://www.greattradingsystems.com/f...-4-indicators/

http://allforexindicators.com/Default.aspx

http://www.metatraderlibrary.com/forex-indicators/

If you want to delete an expert, script or indicator (CAREFUL!), use Windows Explorer to go to the appropriate folder, and

delete the relevant file with the EX4 extension. For example, if you decide that you no longer want to use PCCI, delete file

PCCI.EX4

That will effectively remove PCCI from the custom indicators list in MT4

The file PCCI.MQ4 contains the source code for PCCI (which you copied from the web resource), the PCCI.EX4 file is the

executable code that was created when you did your compile back in step (5). If you want to re-instate the indicator, all you

need to do is reload the source into MetaEditor (press Ctrl-O and open the relevant file), and then press F5 to compile it,

which re-creates the executable file used by MT4.

A more simple way of deleting an expert, script or indicator is by using the Navigator (press Ctrl-N). Click on the item you

wish to delete, press the DELETE key, and click Yes to confirm the deletion. Note that this deletes both the source (.MQ4)

and executable (.EX4) files.

Happy charting!

David

Footnote: the above is repeated in the attached Word doc. If you prefer, you can download the doc, add your own notes to it,

and/or print it out for handy reference.

NOTE: More tips here.

March 27, 2012: Added attached document "How to create a ruler to measure multiple R-multiple profit targets".This is

handy if you want a measuring tool where you want to vary a SL setting, and have multiple TP settings (that are R-multiples

of the SL) adjust themselves automatically. It uses MT4's in-built Fibonacci Channels facility, so there's no third-party indy

required.

Miscellaneous links

Solving Vista/Win7 problems: http://4xtrader.net/how-to-run-metat...ws-7-or-vista/

7bit's Debug View thread: http://www.forexfactory.com/showthread.php?t=245303

Steve Hopwood's EA shell: http://www.forexfactory.com/showthread.php?t=282290

MQL4 tutorials: http://www.forexfactory.com/showthread.php?t=6011

see also: http://www.forexfactory.com/showthre...54#post4485554

MQL4 tutorials (full list of links):

http://www.forexfactory.com/showthread.php?t=6011 (zip files with full tutorials)

http://www.metatrader.info/node/34

http://articles.mql4.com/404

http://articles.mql4.com/417

http://articles.mql4.com/466

http://articles.mql4.com/516
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http://articles.mql4.com/536

http://book.mql4.com/

http://docs.mql4.com/ (MQL4 reference manual)

http://www.forexfactory.com/showpost.php?p=2160415

Check out Jim Dandy's excellent MQL4 tutorial videos here: http://www.jimdandyforex.com/lessonvideo-links/

Br0ker comparison links: http://www.forexfactory.com/showthread.php?t=282549

TA resources: http://www.forexfactory.com/showthread.php?t=106577

Useful MQL4 functions (my functions library): http://www.forexfactory.com/showthread.php?t=165557

Format of HST files here: http://www.forexfactory.com/showthre...08#post1477708

Export price history to Excel here: http://www.forexfactory.com/showthre...89#post1479389 (see later posts in thread also)

and updated here: http://www.forexfactory.com/showpost...37#post1935637

Export History indicator: http://www.forexfactory.com/showthre...44#post2831344

Export bid/ask to Excel (SMJones, DDE-sample.xls): http://www.forexfactory.com/showthre...23#post1815623

MT4 Expert Advisor Builder: http://sufx.core.t3-ism.net/ExpertAdvisorBuilder/

Another strategy builder: http://forexsb.com/wiki/start

MQL4: Manual: http://book.mql4.com/

Documentation: http://docs.mql4.com/

Interpreting System Tester Report numbers: http://www.metaquotes.net/experts/ar...tester_report/

Link to MQL4 resources: http://www.forexfactory.com/showpost...15#post2160415

Trade/exit management EAs: http://www.forexfactory.com/showthread.php?t=89371 and http://www.forexfactory.com

/showthread.php?t=9553

Compendium of EAs (mainly trade management) in forexsaint’s thread: http://www.forexfactory.com

/showthread.php?t=193727

Why MT4 is so widely used: http://www.forexfactory.com/showthre...88#post2785588

What the numbers in MT4's Expert Testing report mean: http://articles.mql4.com/83 and http://articles.mql4.com/127

Using MT4 to plot non-forex charts: http://www.forexfactory.com/showthread.php?t=208577

and http://www.forexfactory.com/showthread.php?t=20535

Reading/writing files outside …\experts\files folder: http://articles.mql4.com/720 and http://codebase.mql4.com/4086

Executing external program: http://forum.mql4.com/16121#109022 and http://support.microsoft.com/kb/238245

How to set up e-mail alerts in MT4: http://broguetraders.com/2011/02/11/...in-metatrader/

also http://www.forexfactory.com/showthread.php?t=23638

and http://www.forexfactory.com/showthread.php?t=273034

MetaTrader 4 Strategy Tester Tutorial: http://www.easyexpertforex.com/backt...imization.html

How to attain 90% modelling quality: http://alansforexblog.com/2008/02/27...pert-advisors/

Free data source for EAs: http://www.forextester.com/datasources.html

EA review/constriction info: http://eareview.net/tick-data

Trade juice table on statistical validity: http://www.tradejuice.com/system-tra...ing-system.htm

Ideas on backtesting: http://www.forexfactory.com/showthre...37#post6160037

Possible sources of tick data:

http://ratedata.gaincapital.com/

http://www.forextickdata.com/services.htm

http://www.tickplusdata.com/forexlist.htm

http://disktrading.is99.com/disktrading/#FOREX

OMZ to ASCII converter here: http://www.quote-solutions.com/softw...historycentre/

http://www.tssupport.com/services/hc/

http://www.goforex.net/forex-directory/forex-data.htm

http://www.global-view.com/forex-tra...forex-history/

http://www.thinkingstuff.com/Resourc...5/Default.aspx

MT4 script to convert tick data to FXT/HST format: http://codebase.mql4.com/516

Free programming threads:

http://www.forexfactory.com/showthread.php?t=168808

http://www.forexfactory.com/showthread.php?t=166758

http://www.forexfactory.com/showthread.php?t=212422

http://www.forexfactory.com/showthread.php?t=197798

How to read/interpret the stats on a Trade Explorer: http://www.forexfactory.com/showthread.php?t=410405

Pips, lots, spread, swap, risk, position sizing, margin, leverage calculations explained: http://www.forexfactory.com

/showthre...85#post2285285
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Excellent post David

Hi all,

In reference to Crosshair mode, and ruler tool #3:

While the left button is held down and the mouse moved. The first number is the difference of bars from the initial left

mouse click, the second number is the difference in pips from the initial left mouse click and the third number is the

exchange rate of the present mouse pointer position (in the case of an arrow the tip of the arrow).

Regards,

lucidlamp

Thanks for posting!

Thank you Hanover ... using them already. 

Been a long time since I used this program. I have an EX$ file that I want the indicator, but I do not have the MQ4 file. How

do I get this?

Quoting scottyb159

Been a long time since I used this program. I have an EX$ file that I want the indicator, but I do not have the MQ4

file. How do I get this?

ScottyB159, sorry I only just noticed your post now; don't know if you're still around. Anyway, I'm afraid I can't help you.

What you're asking is how to decompile an executable back to its source code. I don't believe that this can be done. For

starters, the symbol (e.g. variable, array) names in the source code are generally not stored in an executable, hence an

exact reproduction of the original source is impossible.

David

When changing the color parameters on an indicator or line study, instead of choosing one of the 132 preselected colors, you

can either click the Custom button, or simply type in R,G,B where R = the red component, G = the green component, B =

the blue component. Each of these may have a value between 0 amd 255 inclusive. This gives you access to the full color

palette.

To make an indicator invisible, select 'None'.

Note to programmers: the following table gives the R,G,B components of the 132 preselected colors (sorted alphabetically):

Inserted Code

[b][u]    # MT4#  MT4 color token    Hex(RGB)  MT4 constant           R    G    B[/u][/b]

   11  128  AliceBlue          F0 F8 FF  0xF0F8FF             240  248  255

   12  115  AntiqueWhite       FA EB D7  0xFAEBD7             250  235  215

    7   48  Aqua               00 FF FF  0x00FFFF               0  255  255

   13   92  Aquamarine         7F FF D4  0x7FFFD4             127  255  212

   14  114  Beige              F5 F5 DC  0xF5F5DC             245  245  220

   15  110  Bisque             FF E4 C4  0xFFE4C4             255  228  196

   16    1  Black              00 00 00  0x000000               0    0    0
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   17  112  BlanchedAlmond     FF EB CD  0xFFEBCD             255  235  205

   18   50  Blue               00 00 FF  0x0000FF               0    0  255

   19   56  BlueViolet         8A 2B E2  0x8A2BE2             138   43  226

   20   22  Brown              A5 2A 2A  0xA52A2A             165   42   42

   21   82  BurlyWood          DE B8 87  0xDEB887             222  184  135

   22   36  CadetBlue          5F 9E A0  0x5F9EA0              95  158  160

   23   45  Chartreuse         7F FF 00  0x7FFF00             127  255    0

   24   30  Chocolate          D2 69 1E  0xD2691E             210  105   30

   25   75  Coral              FF 7F 50  0xFF7F50             255  127   80

   26   76  CornflowerBlue     64 95 ED  0x6495ED             100  149  237

   27  117  Cornsilk           FF F8 DC  0xFFF8DC             255  248  220

   28   31  Crimson            DC 14 3C  0xDC143C             220   20   60

   29   12  DarkBlue           00 00 8B  0x00008B               0    0  139

   30   18  DarkGoldenrod      B8 86 0B  0xB8860B             184  134   11

   31   77  DarkGray           A9 A9 A9  0xA9A9A9             169  169  169

   32    2  DarkGreen          00 64 00  0x006400               0  100    0

   33   64  DarkKhaki          BD B7 6B  0xBDB76B             189  183  107

   34   13  DarkOliveGreen     55 6B 2F  0x556B2F              85  107   47

   35   41  DarkOrange         FF 8C 00  0xFF8C00             255  140    0

   36   37  DarkOrchid         99 32 CC  0x9932CC             153   50  204

   37   81  DarkSalmon         E9 96 7A  0xE9967A             233  150  122

   38   69  DarkSeaGreen       8F BC 8B  0x8FBC8B             143  188  139

   39   19  DarkSlateBlue      48 3D 8B  0x483D8B              72   61  139

   40    3  DarkSlateGray      2F 4F 4F  0x2F4F4F              47   79   79

   41   23  DarkTurquoise      00 CE D1  0x00CED1               0  206  209

   42   26  DarkViolet         94 00 D3  0x9400D3             148    0  211

   43   58  DeepPink           FF 14 93  0xFF1493             255   20  147

   44   49  DeepSkyBlue        00 BF FF  0x00BFFF               0  191  255

   45   24  DimGray            69 69 69  0x696969             105  105  105

    5   60  DodgerBlue         1E 90 FF  0x1E90FF              30  144  255

   46   27  FireBrick          B2 22 22  0xB22222             178   34   34

   47   15  ForestGreen        22 8B 22  0x228B22              34  139   34

   48  107  Gainsboro          DC DC DC  0xDCDCDC             220  220  220

   49   43  Gold               FF D7 00  0xFFD700             255  215    0

    8   33  Goldenrod          DA A5 20  0xDAA520             218  165   32

   50   53  Gray               80 80 80  0x808080             128  128  128

   51    5  Green              00 80 00  0x008000               0  128    0

   52   67  GreenYellow        AD FF 2F  0xADFF2F             173  255   47

   53  127  Honeydew           F0 FF F0  0xF0FFF0             240  255  240

   54   83  HotPink            FF 69 B4  0xFF69B4             255  105  180

   55   65  IndianRed          CD 5C 5C  0xCD5C5C             205   92   92

   56   10  Indigo             4B 00 82  0x4B0082              75    0  130

   57  126  Ivory              FF FF F0  0xFFFFF0             255  255  240

   58   90  Khaki              F0 E6 8C  0xF0E68C             240  230  140

   59  121  Lavender           E6 E6 FA  0xE6E6FA             230  230  250

   60  129  LavenderBlush      FF F0 F5  0xFFF0F5             255  240  245

   61   35  LawnGreen          7C FC 00  0x7CFC00             124  252    0

   62  113  LemonChiffon       FF FA CD  0xFFFACD             255  250  205

   63   96  LightBlue          AD D8 E6  0xADD8E6             173  216  230

   64   86  LightCoral         F0 80 80  0xF08080             240  128  128

   65  119  LightCyan          E0 FF FF  0xE0FFFF             224  255  255

   66  111  LightGoldenrod     FA FA D2  0xFAFAD2             250  250  210

   67  102  LightGray          D3 D3 D3  0xD3D3D3             211  211  211

   68   91  LightGreen         90 EE 90  0x90EE90             144  238  144

   69  106  LightPink          FF B6 C1  0xFFB6C1             255  182  193

   70   88  LightSalmon        FF A0 7A  0xFFA07A             255  160  122

   71   25  LightSeaGreen      20 B2 AA  0x20B2AA              32  178  170

   72   94  LightSkyBlue       87 CE FA  0x87CEFA             135  206  250

   73   57  LightSlateGray     77 88 99  0x778899             119  136  153

   74   95  LightSteelBlue     B0 C4 DE  0xB0C4DE             176  196  222

   75  118  LightYellow        FF FF E0  0xFFFFE0             255  255  224

   76   46  Lime               00 FF 00  0x00FF00               0  255    0

    4   39  LimeGreen          32 CD 32  0x32CD32              50  205   50

   77  120  Linen              FA F0 E6  0xFAF0E6             250  240  230

    6   51  Magenta            FF 00 FF  0xFF00FF             255    0  255

   78    9  Maroon             80 00 00  0x800000             128    0    0

   79   68  MediumAquamarine   66 CD AA  0x66CDAA             102  205  170

   80   21  MediumBlue         00 00 CD  0x0000CD               0    0  205

   81   66  MediumOrchid       BA 55 D3  0xBA55D3             186   85  211

   82   73  MediumPurple       93 70 DB  0x9370DB             147  112  219

   83   29  MediumSeaGreen     3C B3 71  0x3CB371              60  179  113

   84   79  MediumSlateBlue    7B 68 EE  0x7B68EE             123  104  238

   85   34  MediumSpringGreen  00 FA 9A  0x00FA9A               0  250  154

   86   59  MediumTurquoise    48 D1 CC  0x48D1CC              72  209  204

   87   28  MediumVioletRed    C7 15 85  0xC71585             199   21  133

   88   11  MidnightBlue       19 19 70  0x191970              25   25  112

   89  130  MintCream          F5 FF FA  0xF5FFFA             245  255  250
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   90  122  MistyRose          FF E4 E1  0xFFE4E1             255  228  225

   91  105  Moccasin           FF E4 B5  0xFFE4B5             255  228  181

   92  104  NavajoWhite        FF DE AD  0xFFDEAD             255  222  173

   93    7  Navy               00 00 80  0x000080               0    0  128

  133  133  None               00 00 00  C'0x00,0x00,0x00'      0    0    0

   94  123  OldLace            FD F5 E6  0xFDF5E6             253  245  230

   95    4  Olive              80 80 00  0x808000             128  128    0

   96   16  OliveDrab          6B 8E 23  0x6B8E23             107  142   35

    2   42  Orange             FF A5 00  0xFFA500             255  165    0

   97   40  OrangeRed          FF 45 00  0xFF4500             255   69    0

   98   72  Orchid             DA 70 D6  0xDA70D6             218  112  214

   99  100  PaleGoldenrod      EE E8 AA  0xEEE8AA             238  232  170

  100   97  PaleGreen          98 FB 98  0x98FB98             152  251  152

  101  101  PaleTurquoise      AF EE EE  0xAFEEEE             175  238  238

  102   74  PaleVioletRed      DB 70 93  0xDB7093             219  112  147

  103  116  PapayaWhip         FF EF D5  0xFFEFD5             255  239  213

  104  108  PeachPuff          FF DA B9  0xFFDAB9             255  218  185

  105   55  Peru               CD 85 3F  0xCD853F             205  133   63

  106  109  Pink               FF C0 CB  0xFFC0CB             255  192  203

    9   89  Plum               DD A0 DD  0xDDA0DD             221  160  221

  107   99  PowderBlue         B0 E0 E6  0xB0E0E6             176  224  230

  108    8  Purple             80 00 80  0x800080             128    0  128

    3   52  Red                FF 00 00  0xFF0000             255    0    0

  109   71  RosyBrown          BC 8F 8F  0xBC8F8F             188  143  143

  110   62  RoyalBlue          41 69 E1  0x4169E1              65  105  225

  111   14  SaddleBrown        8B 45 13  0x8B4513             139   69   19

  112   84  Salmon             FA 80 72  0xFA8072             250  128  114

  113   78  SandyBrown         F4 A4 60  0xF4A460             244  164   96

  114   17  SeaGreen           2E 8B 57  0x2E8B57              46  139   87

  115  125  Seashell           FF F5 EE  0xFFF5EE             255  245  238

David

Attached Image (click to enlarge)

Hi David,

Hope you can help. I am looking to get weekly vertical lines on my chart to look at the weekly pattern and cycles. Have you

got any suggestion, sorry for the basic nature of the request. I have searched for an iddicator, and have not found one.

Many thanks for your assistance.

2be

Quoting 2be

Hi David,

Hope you can help. I am looking to get weekly vertical lines on my chart to look at the weekly pattern and cycles.

Have you got any suggestion, sorry for the basic nature of the request. I have searched for an iddicator, and have

not found one.

Many thanks for your assistance.

2be

2be, sorry for the belated reply, I just noticed your post now.

Press Ctrl-Y on an H4 chart to toggle vertical weekly lines on/off. To get weekly lines on other timeframe charts, you would

need to write a script or indicator.

On H1 charts and below, Ctrl-Y plots a vertical line at the start of each day.

On H4 charts, Ctrl-Y plots a vertical line at the start of each week.

On D1 charts, Ctrl-Y plots a vertical line at the start of each month.

On W1 and MN charts, Ctrl-Y plots a vertical line at the start of each year.
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Best wishes,

David

Hanover

It's a wonderful guide.

I want to know whether there is any way (including using outside software like Doodle ) to insert small text boxes on the

chart to explain strategy.

Text label : what is the maximum letters of word can it have?

thanks again for sharing your tips.

Quoting hanover

2be, sorry for the belated reply, I just noticed your post now.

Press Ctrl-Y on an H4 chart to toggle vertical weekly lines on/off. To get weekly lines on other timeframe charts,

you would need to write a script or indicator.

On H1 charts and below, Ctrl-Y plots a vertical line at the start of each day.

On H4 charts, Ctrl-Y plots a vertical line at the start of each week.

On D1 charts, Ctrl-Y plots a vertical line at the start of each month.

On W1 and MN charts, Ctrl-Y plots a vertical line at the start of each year.

Best wishes,

David

Quoting pj9100

Hanover

It's a wonderful guide.

I want to know whether there is any way (including using outside software like Doodle ) to insert small text boxes

on the chart to explain strategy.

Text label : what is the maximum letters of word can it have?

thanks again for sharing your tips.

PJ, apart from the "Insert -> Text" and "Insert -> Text Label" facilities there's nothing that I know of that's available within

MT4. However, these allow one line of text only, so you'd need to place several of them to get a 'paragraph' effect. Text Label

seems to be able to accept any number of characters, but I can't get it to display more than the first 62 of them.

I've never used Doodle.

To do my annotations, I use a screen grabber to cut a section from the MT4 chart, then I paste it in Excel. Then I use the

latter's drawing tools to put text, boxes, arrows, etc on the image. Then I use the screen grabber to cut and paste the

resulting image into Microsoft Paint, which I save as a GIF, and then upload as an attachment to my FF post.

If you're happy to post an entire chart, you don't need a screen grabber. You can use MT4's "File -> Save as Picture" option,

then load the saved file into Excel ("Insert -> Picture -> From File...."). Then add the annotations, and use shift-click to

select them all, then copy and paste into Microsoft Paint.

No doubt there's a much less cumbersome way, but that's how I do it.

David

hi david,

Moving directly to a certain date/time <<< i didnt know we can do that
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thanks 

When life gives you lemons, make lemonade

If you want to extend a trendline without changing it's angle, select it, then while holding the SHIFT key, drag one end of it,

this also works for moving Fibs sidewards...... and a few other objects. Try it :-)

Also if you want to create a completely horizontal trendline, select the trendline, hold the SHIFT key and pull one end of the

trendline back towards the other end of the trendlne and then out the other side, Magic..... ha ha. It works on other objects

too, like some channels.

If you are like me and hate wasting chart space with tool bars, I float all the tool bars up into the title bar area. Like pic

below. I also Unselect the View - Status Bar and Charts Bar, but that probably does not suit many people.

Lastly if you have a Programmable Tilt wheel on your mouse, Tilt is the middle scroll wheel that also rocks left and right,

then you can program them with CTRL-TAB and CTRL-SHIFT-TAB and that allows you to jump from one chart tab to another,

it also works for tabs in Firefox and IExplorer, and it is my most loved add on.

Dean.

Attached Image (click to enlarge)

perception is reality

Quoting hanover

PJ, apart from the "Insert -> Text" and "Insert -> Text Label" facilities there's nothing that I know of that's

available within MT4. However, these allow one line of text only, so you'd need to place several of them to get a

'paragraph' effect. Text Label seems to be able to accept any number of characters, but I can't get it to display

more than the first 62 of them.

I've never used Doodle.

To do my annotations, I use a screen grabber to cut a section from the MT4 chart, then I paste it in Excel. Then I

use the latter's drawing tools to...

David,

Thank you. I just came across an excellent text insert indicator which can insert multiple lines .

Tro_MyNotes
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Attached File

TRO_MyNotes.mq4   6 KB |  2,643 downloads

Great TRO indie on the text inserter. Really helps to make explanations.

Cheers

This is such a useful post is it possible to make this a sticky

Quoting fugly

This is such a useful post is it possible to make this a sticky

Thanks Twee

Is it possible to re-display (earlier) MT4 Alert Pop-Ups after you have pressed the 'OK' button to acknowledge (and remove)

the Pop-Up when it was first displayed?

Thank you, in anticipation.

Quoting Dm3554

Is it possible to re-display (earlier) MT4 Alert Pop-Ups after you have pressed the 'OK' button to acknowledge (and

remove) the Pop-Up when it was first displayed?

Thank you, in anticipation.

MT4 maintains Alerts in a queue in reverse chronological sequence, i.e. the most recent one at the top of the queue. You can

view the others by resizing (expanding) the window. Once you have clicked OK, the only way to recall the queue/window is

to send another alert. For example, you could create a script with the one statement:

Alert("Dummy alert to display queue");

and drag it onto the chart from the Navigator.

The only way that I know of clearing the queue (removing alerts) is to exit and restart MT4.

At least that's to the best of my knowledge, somebody please post a correction if I'm wrong.

2 members viewing: Invisible , jjibl
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